


Какво е Microsoft Word?

Най-важните операции в Word
 

4-те най-често срещани грешки с Word
 

Защо да инвестирам време в изучаване на MS Word?
 

10
11
12
13
13
14
16
18
19
19
23
25
28
28
29
32
35
38
40
42
44
46
47
49
50
52
56
60
62
64

История
За какво се използва MS Word?

 

 
11. Добавяне на корица на
документ 12. Червено
подчертаване на текста

 
Импортиране на PDF изображение в MS Word

4. Headings
5. Поставяне на външен текст

 
6. Форматиране на текст

 
7. Page Break
8. Параграф форматиране
9. Специални символи

 

Коисаразличните нива навладеене на MSWord?
Най-добрият начин да научите Word (от нашия опит и наблюдения)

3
4
6
8

1

Колко струва MS Word?

БОНУС! История на копираните текстове

Вградени теми

1. Пропускаме настройкитезаразмер на листа
2. Използване на Enter за създаване на отстояние между редовете
3. Не използване на стилове
4. Не се слагат разделители на отделните страници (page break)

1.Номерация на страници
2. Автоматично съдържание

БОНУС: Автоматично съдържание на цитираната литература
3. Работа с PDF документи

Създаване на PDF
Отваряне на PDFдокументидиректновWord

БОНУС! Какдаизпишем"и"сударение вWord?
10. Header & Footer

БОНУС! Добавяненаинформация във Footer-a за самия документ

8-те най-често използвани shortcuts в Word



4 Advanced техники в Word
 

65
65
72
72
73
74
76
80
82
83
85
88
88
89
89
93

1. Стилове
Типове стилове

Стил за абзац (Paragraph Style) и стил за символ (Character Style)
Свързан стил (Linked Style)
Стил за таблица (Table Style)
Стил за списъци (List Style)

2. Шаблони
Използване на готови шаблони
Създаване на собствени шаблони

3. Динамични полета в шаблоните
4. Изпращане на еднотипен документ към множество получатели

Type a New List…
Use an Existing List...
Choose from Outlook Contacts...

2

20 БЕЗПЛАТНИ ВИДЕО УРОКА С WORD



Ръководство за Microsoft Word отAula.bg

Microsoft Word е регистрирана търговска марка на Microsoft Corporation.

Microsoft Word, наричан просто Word или MS Word, се предлага както за
операционни системи Windows, така и за Apple устройства.

Microsoft Word е най-използваната програма за текстообработка, с помощта на
която може да създавате всякакъв тип документи. Доброто познаване на
софтуера и умението за прилагане на базисните принципи на работа са от
съществено значение за всеки един професионалист. Независимо дали
правите курсов проект за университета, поздравителна картичка за Коледа
или създавате важен работен файл, доброто познаване на основните
функционалности на MS Word ще ви помогне да създавате добре
структурирани и професионално изглеждащи документи. Съдържанието е
важно, но не по-малко значимо е как то ще бъде представено! Затова
създадохме следното Word ръководство, чиято цел е да ви запознае с
програмата и нейните най-важни функции. С тяхна помощ ще работите
много по-ефективно с нея и ще създавате професионално изглеждащи
документи!

Microsoft Word е най-използваната текстообработваща програма, проектирана
от технологичната корпорация Microsoft. MS Word е част от софтуерния пакет
за продуктивност Microsoft Office, заедно с Excel и Powerpoint, но може да бъде
закупен и като самостоятелен продукт. Днес към този офис пакет се
присъединяват програмите Access, Publisher, OneNote и Outlook - всички от
които безпроблемно се интегрират една с друга.

Какво е Microsoft Word?
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История
През 1981 г. Microsoft наема Чарлз Симони да разработи приложение за
текстообработка и първата версия е пусната през 1983 г. Тогава водеща
текстообработваща програма на пазара е WordPerfect. Двете програми са с
коренно различна визия, което представлява пречка пред MS Word да пробие
на пазара. Въпреки това Microsoft не спира да усъвършенства програмата през
годините, благодарение на което днес тя е най-използваният текстови
редактор.

През 1985г. Microsoft пускат версия на Word, която е съвместима с Mac
устройства, а само 2 години по-късно корпорацията реализира второто голямо
издание на програмата. То се характеризира с надграждане на основните
функции и добавяне на много нови такива, като поддържане на
обогатентекстов формат (RTF).

WordPerfect 3.x (DOS)

MICROSOFT WORD 1.0 FOR MAC (1985)
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През 1995 г. Microsoft увеличава пазарния си дял в текстообработващия бизнес с
пускането на Windows 95 и Office 95, които предлагат пакетен набор от софтуер за
офис продуктивност.

Ето някои от функциите на MS Word, допринесли за това да се превърне в
най-популярната и предпочитана текстообработваща програма през последните
две десетилетия:

●WYSIWYG (what-you-see-is-what-you-get) дисплей- функция,
гарантираща, че всичко, което се визуализира на екрана в програмата, ще
изглежда по същия начин, когато се отпечата или премести в друг формат
или програма. Минималната загуба на форматиране при копиране и
поставяне на съдържание от MS Word в други платформи, е изключително
ценно за потребителите и е огромно предимство на програмата.
Вграден речник за правопис- при грешно изписванена думите, те биват
маркирани с червено подчертаване.
Функции на ниво текст- удебеляване на шрифта (bold),подчертаване
(underline), курсив (italic) и зачертаване (strike-through).
Функции на ниво страница- задаване на отстъпи, разделянена
параграфи и подравняване.
Съвместимостс много други програми, включително всичкиот Office
пакета на Microsoft.

●

●

●

●

През 2007 г. .docx стана файловият формат по подразбиране, заменяйки
разширението „.doc“.
През 2011 г. Microsoft пускат Office 365 - SaaS (software as a service) решение. Тази
услуга е базирана на абонамент, който се заплаща на месечна или годишна база и
е от голяма полза за организациите, защото им помага да работят много
по-ефек тивно.
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За какво се използва MS Word?
На пръв поглед отговорът на този въпрос изглежда прекалено очевиден - все пак
това е текстообработваща програма и е логично, че се използва за създаването на
текстови документи. Но този отговор е прекалено повърхностен. Ще се изненадате
за колко много неща може да използвате тази програма не само на работното си
място, но и за личните си нужди.

Можете да създадете всякакъв бизнес документ, включително презентации,
предложения, фирмени отчети, планове и бюджети.

Word ви помага да създавате промоционални и маркетингови материали
като брошури, листовки и бюлетини, които можете да изпращате към
потенциални и настоящи клиенти. Можете също да форматирате и
изработите свои собствени бланки и визитни картички. Това може да е
особено полезно за малки фирми, които не желаят да отделят много
средства от бюджета си за дизайн и печат на трети страни.

Бизнесите използват Word, за да управляват своята изходяща кореспонденция. С
помощта на функцията за обединяване на имейли (mail merge function),
автоматично може да се попълни шаблон за писмо с информация за контакт и
адрес, като се използват базите данни, които сте създали в Word или други
програми от Office пакета като Excel или Outlook, които можете да импортирате.
Това ще ви позволи да изпратите едно и също писмо към множество получатели.
Word може също да отпечатва адресни етикети и пликове.

● Писма и поща

● Изработка на рекламни материали

● Създаване на документи и формуляри
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●Други приложения на MS Word:

● Изграждане на бранд идентичност

Може да използвате текстообработващата програма Word за създаване на:

● каталози;
● постери;
● банери;
● визитки;
● фактури;
● покани;
● сертификати;
● книги;
●

●

PDF файлове;
карта с рецепти и др.

Имате възможността да създавате шаблони на документи, писма и т.н., които да
бъдат използвани от всички служители в една компания.
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4-те най-често срещани грешки с Word

1.Пропускаме настройките за размер на листа

13

Това е изключително голяма грешка, особено когато създаденият документ ще
бъде принтиран. По подразбиране голяма част от документите се съхраняват в
размер Letter, което не е такъв голям проблем, ако документът няма да се
разпечатва. Но, ако той е предвиден за печат, то следва да изберем размер на
файла, който да отговаря на размера на листа, който нашият принтер използва.
Той най-често е A4, като вече почти никъде не се използват принтери, които да
разпечатват на хартия с размер Letter. Затова, ако в Word сте задали размер
Letter, а принтерът ви разпечатва на размер A4, то ще ви се размести целия
текст, както хоризонтално, така и вертик ално. За да избегнете тези проблеми
следва да проверите и настроите размера на вашия документ. Това става като
отидете в Layout раздела и изберете Page Setup. В подраздел Paper ще видите
размера на вашия лист. От там можете да изберете и правилния размер, който
да съответства на този на вашия принтер.



2.Използване на Enter за създаване на отстояние между
редовете

Ако имаме няколко заглавия в един документ и искаме това правило да важи
за всички тях, не е необходимо да го прилагаме по отделно за всяко едно
заглавие. Ако добре сме си форматирали текста (ще разгледаме как в т....), то
можем да зададем тези параметри на заглавието като универсални и
съответно да се прилагат на всички останали. Това става след като маркираме
заглавието, отидем на секцията Styles и с десен бутон кликнем върху Heading 1.
Ще ни се отворят няколко опции, но на нас ни трябва "Update Heading 1 to Match
Selection". Така всички наши заглавия ще имат еднакви отстояния от основния
текст и ще изглеждат по един и същи начин.
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Друга често срещана грешка, която повечето хора допускат и която е причината
текстът ни да се размества и документът ни да не изглежда професионално е
използването на Enter и/или Space bar-a, когато искаме да създадем отстояние
между редовете. Например ако искаме да имаме разстояние между заглавието и
основния текст е абсолютно грешно и непрофесионално да го правим с Enter.
Това, което следва да направите е първо да маркирате тази част от текста, за
която да създадете отстояние. В конкретния пример това е заглавието "Царевец".
След това влизате в разширението "Paragraph" и от там в секцията Spacing може
да изберете колко пунктна да е отстоянието преди и/или след заглавието.
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3. Не използване на стилове

Заглавията ни позволяват да скриваме основния текст като кликнем върху
стрелкичката до тях, което представлява едно удобство при четене на документа.
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Голяма част от хората, работещи с Word на "интуитивно" ниво, не използват
вградените стилове, които ни помагат да работим ефективно с програмата и да
постигаме професионални резултати. Това създава редица проблеми от
естетическа, но и функционална гледна точка. Вместо това, когато трябва да
представят даден текст като заглавие, те просто увеличават големината на
шрифта и болдват текста, което нарушава цялостната структура на документа.
Затова след като въведем нашия текст в Word следва да определим кои са
заглавията, подзаглавията, основния текст, цитатите и т.н. След което трябва да
приложим вградените стилове за форматиране.



Малко по-надолу в ръководството ще разгледаме защо е важно да използваме
тези стилове и кои инструменти зависят от това.
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4. Не се слагат разделители на отделните страници (page
break)

След като използваме тази функция, каквото и да изтриваме и/или добавяме
преди това заглавие, то ще си стои на нова страница.

Бързият клавиш за тази функция е CTRL + ENTER. Кликнете в началото на
самия ред, наберете тази комбинация и текстът ви ще отиде на нова страница.
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Навярно ви се е случвало, когато въвеждате текст в Word, подзаглавието ви да
остане на последния ред на страницата, а текстът след него да отиде на
следващата. В такава ситуация най-често допусканата интуитивна грешка е да
кликнем пред заглавието и да ударим един Enter и с това си мислим, че
проблемът е решен. Но ако се наложи да изтрием или въведем текст преди
това заглавие, то отново ще се размести. Затова най-оптималният начин да се
справим с този "проблем" е да използваме опциятаPage Break, която ще
намерим в секцията Layout.



Най-важните операции в Word

1. Номерация на страници

Това е относително лесно и дори хората, работещи на интиутивно ниво с Word
го знаят. Но какво трябва да направим, ако искаме номерирането да започне
от различна страница? В повечето случаи първо имаме заглавна страница и
съдържание, които не искаме да номерираме. За целта, първо, ще трябва да
създадем т.нар. секция. Това се случва след като отиден в началото на нашия
основен текст, от който искаме да започне номерирането на страниците,
влезем в секцията "Layout", изберем "Breaks" и кликнем върху "Next Page". По
този начин разделяме документа на 2 секции - заглавна страница +
съдържание и основен текст.

Номерирането на страниците е едно от задължителните условия нашия
документ да има завършен и професионален вид. За целта влезте в секцията
"Insert" и изберете "Page Number". От там ще ви се покажат няколко опции за
позицията и вида на самата номерация.
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Но двете секции все още са еднакви и са закачени една за друга. Затова
следващата стъпка е да маркираме втората секция (2 последователни клика
върху footer-a) и да изберем бутона "Link to Previous". По този начин
"откачаме" двете секции и ще можем да създадем различно и независимо
съдържание във footer-a на двете секции.
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След като ни се отвори прозореца за форматиране на номерацията на
страницата виждаме, че по подразбиране стои настройката, която продължава
номерацията от предишната секция. Затова от "Start at:" казваме на Word, че
искаме номерацията да започне от 1.
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Следващата стъпка е да отидем във footer-a на първата секция (заглавна
страница + съдържание) и да изтрием номерацията. Сега "проблемът" е, че
номерацията на текстовата ни част започва с №3, а ние искаме да започва от 1.
Затова маркираме footer-a на секция № 2, кликаме с десен бутон и
избираме"Format Page Numbers".



Важно!!! Ако имате съдържание в началото на документа, не забравяйте
да го актуализирате (прочетете повече за автоматичното съдържание в
следващата точка)!
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2. Автоматично съдържание

23

Създаването на автоматично съдържание е изключително полезно, особено
когато работим с голям обем страници. Възможно е то да бъде направено
ръчно, но определено това не е най-оптималният начин, защото вероятността
от допускане на грешки при номерирането е много голяма. За целта първо
преместваме с Page break или Ctrl + Enter основния текст на нова страница, за
да си освободим място за съдържанието, което трябва да бъде след заглавната
страница. След което влизаме в раздела References и избираме Table of
Contents. След като си изберем определена форма на съдържанието, то ще ни се
визуализира и ще ни се номерират заглавията и подзаглавията.



Ако правим промени по нашия документ - преименуваме, добавяме/
премахваме заглавия или подзаглавия, въвеждаме или изтриваме текст, което
резултира в пренареждане на страниците, то с няколко клика можем да
актуализираме съдържанието. Само трябва да кликнем върху "Update Table..." и
ще ни се появят две възможности - да актуализираме само номерацията на
страниците или цялата таблица.
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Можем да създадем различни категории за различните източници или да
използваме някоя от предложените ни. За целта избираме "Category..." и
наименуваме нашата нова категория (в примера "Цитирани източници").
Натискаме"Replace"и след това"OK".

25

БОНУС: Автоматично съдържание на цитираната литература Това е изключително
полезна функция, особено когато трябва да цитираме много източника, например
при изготвяне на дипломна работа. Тя ни спестява много ръчен труд и време.За
целта още докато създаваме документа следва да си отбележим източниците, които
ще използваме. Това става като отидем в раздел "References", маркираме
съответния източник и кликнем върху "Mark Citation". По този начин казваме на
Word, че това е източник, който сме цитирали.



В предходния прозорец трябва да изберем категорията, която създадохме.
Натискаме "Mark" и след това "Close". След като вече сме заложили нашия
източник, влизаме отново в "References" и избираме "Insert Table of
Authorities". От там избираме нашата новосъздадена категория и
натискаме"ОК".
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На нов ред ни се визуализира източника в тази категория. Ако маркираме
всички източници, още при създаването на самия текстов файл, ще можем с
няколко клика да ги извадим.
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3. Работа с PDF документи

Създаване на PDF
Microsoft Word използва файловията формат DOCX по подразбиране. Но знаете
ли, че може да създадете PDF файл в MS Word? Тази функционалност на
програмата е изключително полезна, тъй като PDF форматът има две ключови
предимства пред стандартния документ на MS Word:

● PDF файловете не зависят от платформата и това ги прави лесни за
споделяне;
PDF файловете са много по-трудни за редактиране, което ги прави
по-защитени от подправяне.

●

Създаването на PDF в MS Word е изключително лесно и бързо. Следвайте
следните стъпки:

1.Отворете документа, който искате да конвертирате в PDF
2.Отворете секциятаFile>Export>Create PDF/XPS
3.Изберете PDF като предпочитан тип файл
4.Изберете ниво на оптимизация ("Стандартен" или "Минимален размер")
5.Изберете име и местоположение за новия файл
6.Щракнете върхуPublish, за да създадете PDF файл
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Новосъздаденият PDF файл не замества оригиналния документ, така че все
още можете да го редактирате в Microsoft Word и да го експортирате отново,
ако трябва да актуализирате PDF-а. Можете също да използвате този метод, за
да създадете XPS файл, който е като PDF, но е много по-рядко срещан формат.

Преди отварянето на PDF файлове в MS Word бе невъзможно. Необходимо бе
използването на външна програма, която да обработи PDF файла, за да
създаде Word файл. Но вече MS Word има такава функционалност, която ни
позволява директно в програмата да отваряме PDF файлове и да можем да ги
редактираме. Но преди да разгледаме как, трябва да споменем, че има 2 типа
PDF файлове - сканиран документи и такъв, който е създаден на компютър
като PDF. При първия вариант не можем да избегнем използването на
специална програма, която да идентифицира отделните знаци, защото в
действителност този документ представлява едно изображение. Докато при
втория тип - можем директно да го отворим в Word. Как става т

● След като предварително сме свалили PDF документа, който искаме да
отворим в Word, кликаме върхуFile > Open > Browseи го намираме.

Отваряне на PDF документи директно в Word
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●Ще ни се отвори прозорец, който ни съобщава, че Word ще конвертира този
PDF в документ на Word, който ще може да се редактира. НатисакмеOK.

● Документът ще ни се визуализира, но все още не можем да го редактираме.
Затова избирамеView > Edit Document.
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След което вече ще можем да правим промени по документа и да го запазим като
DOCX или отново да го експортираме като PDF.
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Импортиране на PDF изображение в MS Word
Когато става дума за импортиране на изображение в текстов документ един от
начините, за който се сещаме, е чрез т.нар. "влачене" на картинката и
поставяне. Това обаче няма да ни свърши работа с PDF изображенията,
защото резултатът ще бъде следният:

Това, което трябва да направим, когато искаме да вкараме PDF изображение в
нашия документ, е:

● Влизаме вInsertи намираме разделText. ИзбирамеObject > Object...
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●Ще ни се визуализират различни обекти от различни програми. На нас ни
трябва програмата, която поддържа нашия PDF документ. Това е Adobe
Acrobat Document. Избираме и натискамеOK.

● Намираме си нашето PDF изображение и го отваряме. Ако изображението
ви е с диагонални черти, то причината за това е, че PDF документът ви е
отворен в Adobe Acrobat.
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● За да изчезнат, просто затворете програмата (Adobe Acrobat).

●По аналогичен начин може да прикачвате в MS Word диаграми, графики,
снимки, документи, сканиран текст и други PDF обекти.
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4. Headings

Преди да ги приложим, следва предварително да сме дефинирали кои части
от текста ни ще бъдат заглавия, подзаглавия, основен текст и т.н. Една от
грешките, която описахме малко по-нагоре в ръководството е, че много хора,
вместо да използват вградените заглавия, увеличават шрифта и болдват
текста, така че да изглежда като заглавие. Но това лимитира възможностите
ни с програмата. Например няма да можем да създадем динамично
съдържание, което е изключително ценно, особено за по-голям обем
документи.

Този фундаментален принцип предполага използването на вградените
заглавни елементи в Word.

35

Има един основен принцип в Word, който ни позволява да използва вградените
инструменти и стилове в програмата. Те, от своя страна, ни позволяват да
работим ефективно и да създаваме професионално изглеждащи документи.



БОНУС! Клавишните комбинации за прилагане на заглавни части
 избрания от вас текст и приложете следните комбинации:

. Маркирайте

Често обаче не ни харесва как изглеждат вградените заглавия и/или искаме да
променим техния стил и да го приложим за всичките ни заглавия. Това обаче е
доста трудоемък и времеемък процес, особено ако трябва да го правим ръчно
за всяко заглавие или подзаглавие. Този "проблем" също има своето решение.
Маркираме си съответния текст и си го форматираме според нашите
изисквания (шрифт, големина, цвят...). След което в секцията Styles кликаме с
десен бутон върху съответния Heading. Избираме "Update Heading 1 to Match
Selection". По този начин автоматично всички заглавни части (Heading 1)
ще станат в един стил. Това е изключително удобно, защото няма нужда да
преправяте всяко заглавие по отделно.

CTRL+ALT+1 - Задаване на Heading 1

CTRL+ALT+2 - Задаване на Heading 2

CTRL+ALT+3 - Задаване на Heading 3
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5. Поставяне на външен текст

Може да достъпите тези опции и в секциятаHome > Paste.

38

Знаете ли, че има няколко начина да поставите външен текст в MS Word? Първият
и навярно най-често използван е чрез командата CTRL + C за копиране и CTRL + V
за поставяне. Но нека да надградим вашите умения с MS Word и да ви запознаем с
различните опции. След като сте копирали текста, който искате да поставите,
отворете нов файл в MS Word и поставете курсора на мишката там, където искате
да се позиционира вашият текст. След което кликнете с десен бутон. Ще ви се
визуализират 3 опции за поставяне:



Първата опция е Keep Source Formatting. Тя ни позволява да поставим текста
като запазим изцяло форматирането на източника.

Втората опция е Merge Formatting. Чрез нея автоматично променяме стила на
копираниятекст,такачетойдабъдеидентиченсостаналиявнашиядокумент.Но се
запазва форматирането, т.е. ако имаме болднат текст, хипервръзки и т.н., те
ще се запазят.
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Знаете ли, че има начин да видите историята на вашите копирани неща и без
да се налага да търсите източника отново, можете за няколко секунди да
намерите и поставите желания от вас текст! Как? Много е лесно!

Ако използвате Windows 10, изберете командата Windows Key + V. Ще ви се
отвори следният прозорец:

Третата опция е Keep Text Only. Тя ни позволява да инпортираме текст в
нашия документ, без форматиране на оригиналния източник. Поставеният
текст ще съответства на избрания от нас стил на документа.

Натиснете Turn On и ще ви се визуализира
историята на вашите копирани текстове.
Предимството е, че това може да го използвате не
само в MS Word, а за всяка една платформа. След
като кликнете върху желания от вас текст, той
автоматично ще се постави на мястото, на което
сте поставили курсора.

БОНУС! История на копираните текстове
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6. Форматиране на текст

Ето и кои саклавишните комбинацииза някои от тях:

●

●

●

●

●

B -Bold(CTRL + B) - удебеляване на текста
I-Italic(CTRL + I) - курсив/наклон на текстаU -
U -Underline(CTRL + U) - подчертаване на текста
Subscript (CTRL + =) - долен индекс
Superscript (CTRL + Shift + +) - горен индекс

След като ръчно сме настроили форматирането на определен текст и искаме да го
приложим на друг (например искаме заглавията ни да изглеждат по един и същи
начин), не е нужно отново да избираме ръчно шрифта, цвета, да настройваме
големината на буквите и т.н. Можем да го направим много по-бъзро като
използваме Format Painter в секцията Clipboard. Маркираме текста, чийто стил
искаме да копираме и избираме Format Painter. След което просто селектираме
текста, върху който искаме да приложилм това форматиране.

Има 2 начина, по които можем да форматираме нашия документ. Първият,
който е по-времеемък, е директното форматиране. То предполага ръчното
използването на следните опции за форматиране на всеки отделен текстови
елемент в док умента:
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Ако искаме да изтрием форматирането на текста, то това става чрез
използването на функцията Clear All Formatting, която се намира в секцията
Font. Просто маркирайте текста, чието форматиране искате да премахнете и
натиснете Clear All Formatting.

Вторият начин за форматиране е много по-бърз и лесен, защото се използват
готови стилове (Headings), като Word ни позволява да създаваме и наши
собствени стилове. Вече споменахме, че тяхното НЕ използване е една от
най-съществените грешки, които начинаещите с програмата допускат. Защо?
Защото директното форматиране отнема много повече време и усилия.
Същевременно прилагането на този метод ограничава възможностите ни с
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Може да достъпите вградените теми като изберете секция
дясно от тях се намират групите със стилове.

. В

програмата. Не можем да създаваме автоматично съдържание, което е
изключително ценно за това да се ориентираме по-бързо в документа, а и за
да изглежда професионално. Но също така не можем да използваме
вградените теми.
Вградени теми

Design > Themes
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Новоизбраната тема актуализира целият ни документ. Ако обаче не ни допада
конкретен елемент, като цвета или шрифта, имаме възможност да променим
само него, без това да окаже влияние върху цялостния дизайн.

ВАЖНО! За да използвате вградените теми, задължително трябва вашият текст
да има правилно изградена структура от заглавия, подзаглавия и т.н. Тоест,
трябва да сте дефинирали отделните елементи на вашия текстов документ и да
сте приложили вградените стилове!
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7. Page Break

Вече споменахме, че това е един от най-често срещани пропуски сред
начинаещите. А, именно когато искаме да отидем на нова страница кликаме
няколко пъти с Enter и готово. Но това е напълно грешен начин, защото при
последваща редакция на текста всичко ще се размести и няма да е на мястото си.
Затова, ако искате определена част от вашия текст да започва на нова
По този начин може да

добавяте или изтривате текст и това няма да разбърка целия ви документ.

Функцията може да достъпите от секцията Layout > Break > Page или чрез
клавишната комбинацияCtrl + Shift

страница, задължително използвайте Page Break!
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8. Параграф форматиране

Малко са хората, които използват функцията на Word за показване на
маркерите за параграфи. Тя е изключително полезна когато редактираме
документ в програмата. Може да я достъпите по следния начин или чрез
клавишната комбинацияCtrl + *.

Тези маркери ни показват къде свършва даден параграф, както и всички
скрити символи за форматиране. По ваш избор може постоянно да държите
включена тази функция, като параграфните символи няма да се отпечатат.

Ако имате бяла страница (както в нашия пример) и искате да разберете

причината
за нея, то включвайки маркерите за параграфи ще раберете на какво седължи. В
случая имаме "Page Break", който създава тази нова страница. За да я

премахнем,
просто кликаме пред параграфния символ и с backspace я изтриваме.
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Забележете, че на втора страница (при автоматичното съдържание) имаме 2
обозначение - Page Break и Section Break (Next Page). Ако си спомняте, в
точката за номерация на страници използвахме тази функция, за да разделим
документа на две секции, така че да може номерацията ни да започне не от
заглавната страница и тази със съдържанието, ами от основната текстова част.
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9. Специални символи
Има 2 начина за добавяне на специални символи в нашия документ. Първият
е като влезете в секцията Insert > Symbol. Ще ви се визуализират най-често
използваните символи, а ако не намирате този, който ви трябва, то кликнете
върху More Symbols...и го намерете.

По-лесният и бърз начин е като въведем ръчно определени знаци, които Word
ги разпознава като символи. Например ако искаме да добавим символа за
търговска марка, то въвеждаме "(tm)" и Word автоматично ни го превръща в
символ. Това правило важи за най-често използваните символи. Важно е да
използвате латиница, защото в противен случай няма да ви се получи!
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БОНУС! Как да изпишем "и" с ударение в Word?
Явно това е голям препъникамък за много хора. Има 3 начина да изпишете "и" с
ударение, като си изберете този, който ще ви бъде най-лесно да наизустите.

1.Задръжте Alt и наберете 1117.
2.Изпишете обикновено "и"и след това отновозадръжтеAlt и наберете

768.
3.Най-лесно запомнящият се начин е просто дазадържитеShift и да

изпишете "ь". Ако искате главно "и" с ударение, тоактивирайте Caps Lock.
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Ето и още някои клавишни комбинации за добавяне на специални символи,
които биха ви били полезни:
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10. Header & Footer

Добавянето на информация в Header-a и Footer-а на вашия Word-овски
документ освен, че ще спомогне за по-добрата ориентация в него, ще му
придаде един завършен и професионален вид. Тази информация може да е
номерация на страниците и/или заглавие на раздел от вашия файл.

За да създадете Header и/или Footer, изберете секцията Insert и кликнете върху
Header/Footer. Ще ви се визуализират различни формати, от които може да
избирате. Има и друг начин да редактирате съдържанието в header-a и footer-a

на
вашия документ. Кликнете два пъти с мишката съответно върху горната или
долната част на листа. Но по този начин няма да ви се покажат различните
формати, а ще може само да променяте информацията.

След като сме избрали определен формат за нашия Header/Footer, можем да
променим определени елементи от него, в зависимост от нашите
предпочитания. След като кликнем върху самото съдържание в горния/долния
колонтитул, ще ни се покаже разделът Shape Format, който ще ни отвори
различни възможности за форматиране на стила. Можем да променяме
цветовете на шрифта и формата, да слагаме ефекти и др.
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След като сме задали съдържанието в header-a и footer-a, то ще се визуализира
на всяка една страница. Ако обаче искаме тази информация да не се вижда на
заглавната ни първа страница, то кликаме два пъти върху горния колонтитул
и избираме опцията "Different First Page". След което кликаме върху "Close
Header and Footer"бутона.

53



Но двете секции все още са еднакви и са закачени една за друга. Затова
следващата стъпка е да маркираме втората секция (2 последователни клика
върху header-a) и да изберем бутона "Link to Previous". По този начин
"откачаме" двете секции и ще можем да създадем различно и независимо
съдържание в header-a/footer-a.
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Само че, не искаме този Header да се вижда и на страницата със съдържанието.
Ако си спомняте, когато говорихме за номерирането на страници, разделихме
документа на две секции, за да може номерацията ни да не започва от заглавната
страница и тази със съдържанието, ами от същинската текстова част. 
Как създавахме тези секции? Първо трябва да поставим курсора в началото на
нашия основен текст, където ще приключи първата секция и ще започне втората. 
След което влизаме в раздела Layout, изберем Breaks и кликнем върху Next Page.
По този начин разделяме документа на 2 секции - заглавна страница +
съдържание (Section 1) и основен текст (Section 2). Това ни позволява да имаме
различно съдържание в Header-a и Footer-a на двете секции.



След което просто отиваме в Header-a на страницата ни със съдържанието и го
изтриваме.

Ако вече сте направили тази стъпка с разделянето на секциите, не е нужно да я
повтаряте. Просто отивате върху Header-a и го премахвате.
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!Добавяне на информация във Footer-a за самия документ

След като изберем File Path във Footer-a ни ще се визуализира информация за
точното местоположение на файла - папки, подпапки, име на проекта.
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Ако работите в голям екип и през вас минават множество документи, то тази
функция ще ви е изключително полезна! Представете си, че държите в себе си
един разпечатън документ или пък имате пред себе си един pdf  файл и искате
да намерите в коя папка се намира оригиналният Word документ, за да може да
го редактирате или да го използвате като шаблон. Но не може да го намерите, а
колегата ви също не си спомня къде е запазил Word-овския файл... Поради тази
причина в много фирми е практика да се добавя информация за точното
местоположение на оригиналния документ във Footer-a. Разбира се, това може
да го направите и ръчно, но има и по-лесен начин, който ще разгледаме. Първо,
кликаме два пъти върху долния колонтитул, за да го активираме. Ще ни се
отворят най-различни опции, но нас ни интересува бутона Document Info. От там
можем да изберем каква информация за документа да извадим - името на
автора, името на файла, заглавието на документа или "пътят" към файла.



Ще ви се визуализират множество възможности за динамични полета, като размер
на файла, брой думи, дата и час на редакция и т.н.

Под този текст може да добавяте още информация за самия файл, ако такава е
необходима. Изберете отновоDocument Info>Field...
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В нашия пример избрахме да визуализираме броя на думите и когато
добавяме или премахваме текст, трябва да актуализираме тази информация.
Това става като кликнем два пъти във Footer-a и с десен бутон изберем броя на
думите. Ще ни се покаже опцията "Update Field".

Ако искате тази част от документа да изглежда още по-професионално, то
добавете 3 минуса над информацията с местоположението на файла и
натиснете Enter. Така ще ви се визуализира една разделителна линия, която да
отделя тази информация от останалата в документа.

Също така може да направите шрифта много малък, защото това е информация,
която ни е нужна само в определени ситуации и не е част от основния текст.
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Внимавайте да не добавяте информация, която не е редно да се разпечатва!
 Изберете информацията, която ще бъде полезна на вас и колегите ви.
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11. Добавяне на корица на документ

След като изберем нашия дизайн, попълваме празните полета и изтриваме
следващата страница с текста, който вече не ни е необходим.

Не са ви необходими специални дизайнерски умения, за да създадете корица
на вашия документ, защото в Word има вградени такива. За да ги достъпите
влезте в разделInsert > Cover Page.
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След като кликнем два пъти върху елементите от корицата, ще ни се отвори
раздела Shape Format. Той ни предлага различни опции за модификация на
елементите.
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12. Червено подчертаване на текста
Червеното подчертаване ни показва, че имаме правописна грешка в текста си.
Но понякога това не означава, че сте изписали думата грешно, ами че сте
задали друг език на работа. Как да го смените? Първо, маркирайте целия
текст. Това става най-лесно с клавишната комбинация Ctrl + A. След което
отидете в най-долната лента на екрана и натиснете върху езика. Ще ви се
отвори прозорец, от който може да изберете този, на който създавате вашия
документ. Натиснете OK и червеното подчертаване ще изчезне.

Но, ако все пак има определени думи, които са подчертани, то това се дължи
на факта, че те са нови за самата програма и тя ги разпознава като грешни.
Това, което може да направите е да кликнете с десен бутон върху думата и
вместо да я игнорирате като натиснете Ignore All, я добавете към речника като
изберете "Add to Dictionary".
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По този начин Word ще премахне подчертаването на думата в целия ви документ,
вече ще я разпознава и няма да я подчертава като грешна!
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4 Advanced техники в Word

1. Стилове
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Стиловете са най-добрият начин да имаме консистентни и добре форматирани
документи в Word. Те също така ни пестят време, което ни помага да работим по-
бързо и по-ефективно. Само с един клик за смяна на стила можем да модифицираме
дълги документи и да ги направим да изглеждат красиви и професионални. Има едно
правило, което ако усвоите, ще започнете да работите много по-ефективно с
програмата. То е, че ако форматирането на даден текст се повтаря из документа
(например заглавия на фрагменти от текста), то за този стил. Веднъж създадени,
стиловете могат да бъдат използвани многократно!
Всъщност всеки, който работи с Word използва стилове, дори и да не го осъзнава,
защото те са в основата на работата с програмата. Има няколко типа стилове, които
ще разгледаме след малко. Вече обсъдихме какво представлява директното
форматиране и защо това не е най-оптималният начин да работите с Word. Ако
работим с дълги текстове, то ръчното форматиране на всеки отделен елемент ще ни
отнеме прекалено много време. Затова е важно да се научите да работите със
стилове. По този начин ще вършите работата си много по-бързо и ще имате
консистентност във вашите док ументи.
Работата със стилове се състои в това да дефинирате различните части от вашия
текст каква "роля" имат в него - основно заглавие, подзаглавие, второ подзаглавие,
цитат и т.н. След което трябва да приложите готовите стилове в Word за тези
елементи.



Готови стилове
Предимството на това да използваме стилове, вместо директно да форматираме
текста е, че можем с няколко клика да правим промени по целия документ.
Нека разгледаме един пример:
В следния пример използвах стила

Дефиниране на ролята на всеки параграф

за определенидуми от текста."Strong"
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Отваря ни се прозорец, който ни предлага различни възможности за промяна на
стила.

Можех просто да използвам функцията Bold, но тя ограничава
възможностите ни с програмата.

Сега обаче искам думите, които са в стил "Strong" да бъдат в оранжев цвят.
Вместо да си играя цял ден и да ги правя една по една, намирам стила, кликамс
десен бутон и избирам опцията"Modify...".
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Избираме Format > Font... и ни се отваря още един прозорец. От падащото меню
Font Color избираме желания от нас цвят и натискаме OK.
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Тази промяна ще се отрази автоматично върху всички думи в целия документ,
които са били форматирани със стила Strong.
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По аналогичен начин можем да подравним нашия основен текст, без да е
необходимо да селектираме всеки абзац и да форматираме директно чрез
иконките в секция Paragraph. За целта кликаме с десен бутон върху стила
Normal и избираме Modify. От прозореца, който ще ни се отвори, избираме
желаното от нас подравняване и натискаме ОК.
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Стил за абзац (Paragraph Style) и стил за символ (Character Style) За да достъпите

всички стилове и опции, кликнете върху стрелката за разширение
в долния десен ъгъл на полето със стилове или наберете комабдата Alt + Ctrl +
Shift + S. Ще ви се визуализират различните стилове, а срещу тях ще видите
символи.
Стиловете, които са само за параграф са обозначени със символа, който
разглеждахме в раздела "Параграф форматиране". Те могат да се прилагатсамо
върху абзаци, но не и върху отделни думи или фрази.

По този начин основният текст в целия документ ще се подравни по желания
от нас начин.

След като правилно сте изградили структурата на вашия текст, изолзвайки
вградените стилове, можете си изберете тема, която да приложите. Темите ще
намерите в секция Design > Themes. (Разгледахме по-детайлно темите в

 

Тези стилове, срещу които има символ за параграф и буква, могат да се
използват, както за отделни думи и символи, така и за цели параграфи. А, тези
от тях, срещу

точката "Вградени теми")

Типове стилове
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които има само буква, означава, че са стилове, които могат да се прилагат само
върху думи и символи.

Свързан стил (Linked Style) Това са стилове, които могат да бъдат прилагани

както върху отделни думи, така и
върху цели абзаци, в зависимост от това какво сте избрали. Ще ги познаете по
символа, който съдържа буква и параграф.

Ако изберете целия абзац и приложите свързания стил, то той ще се приложи
върху целия параграф.
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Ако обаче изберете конкетна дума или фраза в абзаца и приложите свързания
стил, то той ще се приложи като символен стил и няма да има отражение
върху абзаца.

Стил за таблица (Table Style) Ако имаме таблица/и в нашия документ, то в Word

има вградени стилове и за тях,
които можем да използваме. След като кликнем върху нашата таблица в
най-горната лента ще ни се появи меню с инструменти за таблици (Table

Tools).
За да достъпим стиловете, трябва да изберем секциятаTable Design.
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Ще ни се визуализират множество стилове, от които можем да избираме.
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Избрах стил, който подхожда на цялостния дизайн на документа.

Стил за списъци (List Style)

Ако имате списъци във вашия документ, то и за тях има вградени стилове, които
може да използвате и да модифицирате по аналогичен начин.
След като сте избралия вашия списък, кликнете с десен бутон върху List

 Paragraph > Modify...
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Ще ви се визуализират вече познатите опции за модификация. Това обаче,
което искам да направя, е да сложа рамка на моя списък. За целта избирам
Format > Border...и си моделирам рамката.

Ако искам да сменя самите булети или да създам такива, които да пасват на
стила на целия документ, то трябва да кликна върху стрелката до опцията за
булети и да избераDefine New Bullet...
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Ще ми се отвори прозорец с най-различни опции за типа на булета - изображение
или символ, както и позицията му в документа.

Аз ще кликна върху Symbol и ще
си избера някой, който ми
допада. После ще кликна върху
опцията Font... и ще си избера
цвят на булета. След като веднъж
сме го създали, можем да го
използваме многократно. Ето го и
резултата:
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2. Шаблони

Всеки нов документ, който стартираме в Word започва от шаблон. Обикновено
неговите настройки са зададени по подразбиране. Например често когато
създаваме нов документ в последствие се оказва, че форматът ни не е A4, а е с
размер Letter. Това може и да не е чак толкова голям проблем, ако този
документ няма да се разпечатва. Но в противен случай принтерът или няма да
ни изпринтира документа, или текстът ни в него ще бъде разместен. Затова
ние всеки път трябва да проверяваме размера на нашия шаблон и да го
настройваме. Но това би ни отнемало прекалено много време всеки път, щом
създаваме нов документ. Затова имаме възможността да променим
стандартния шаблон и да направим така, че тези настройки да се
запаметят завинаги. По този начин всеки път, когато стартираме Word,
настройките на шаблона ще са направени!

Как да го направим? Отиваме в секциятаLayout

>Size > More Paper Sizes...
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Ще ни се отвори прозорец, от който можем да видим и променим размера на
листа. Избираме си размер A4 и за да зададем този шаблон като стандарт, то
трябва да  кликнем върху бутона "Set As Default". След което ще ни се отвори
прозорец с въпрос дали сме сигурни, че искаме да променим настройките по

подразбиране на шаблона.



След като изберем даден шаблон, можем да го свалим от Интернет чрез бутона
"Create".

Тези шаблони ни спестяват време и усилия, които бихме отделили, за да ги
създадем и също така допринасят за професионалната визия на документите ни.

В Word освен шаблон с празен документ, има много други, които можем да
достъпим, ако сме свързани с Интернет.

Тях ще намерим в секцията File > New. Там ще открием множество категории с
дизайнерски шаблони.

Използване на готови шаблони
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По аналогичен начин можем да променим настройките на полетата. Избираме
Margins > Custom Margins... Задаваме разстоянията от ляво/дясно, горе/долу,
избираме си ориентация на шаблона и кликаме върху бутона "Set As Default"
От тук нататък вече новите файлове, които създавате, ще бъдат с тези настройки
на листа.



Създаване на собствени шаблони
Собствените шаблони са изключително ценни, особено ако ще ги използвате многократно.
Например искате да създадете бланка с името, логото и адреса на вашата фирма
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в header-a, която да може да преизползвате.
 

За целта след като сте създали
вашия шаблон, трябва да го запаметите като темплейт!



Избираме си бланката и тя ни се отваря като нов файл.

Сега, ако искаме да използваме тази бланка, трябва просто да отидем във File
> New > Personal/ Custom. Там ще ни се визуализират всички създадени от нас
шаблони, които можем да използваме многократно.
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3. Динамични полета в шаблоните

Не забравяйте преди това да сте кликнали на точното място в документа,
където да се постави тази информацията!
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Същото можем да направим и с датата и името на фирмата. За да се попълва
автоматично датата влизаме в Insert > Date & Time, като преди това сме кликнали
върху мястото, на което да се визуализира тази информация. Ще ни се отвори

прозорец с опции за форматиране, от които можем да избираме.

Ако вече сме си създали шаблон с вградена структура, който ще преизползваме, то
можем да направим така, че част от информацията в него да се попълва автоматично,
което ще ни спести допълнително време и усилия. В конкретния пример искаме да
направим така, че който отвори шаблона да се попълва автоматично неговото име на
мястото на автора. В самия документ има елементи, които носят информация
(метаданните към документа). Тях ще открием в секцията Insert > Quick Parts >
Document Property. За да се визуализира името на човека, създаващ писмото, то
трябва да изберем Author. По този начин автоматично ще се попълва името на човека,
който попълва шаблона, стига предварително да си го е вписал в свойствата на
документа (ще стане ясно малко по-надолу).



Ако искате да промените свойствата на самия документ (да добавите име на
компания или да смените автора), то изберете File > Info > Properties >
Advanced Properties. Ще ви се отвори прозорец, в който може да попълвате
всякаква информация в полетата, която ще се отрази във във вашите
документи и по-точно - в динамичните полета.

За да ни се попълва автоматично името на фирмата при отваряне на шаблона,
влизаме отново в Insert > Quick Parts > Document Property и избираме
Company.

По този начин създадохме динамични полета, които можем да променяме

бързо и
лесно. Трябва само да запазим този документ като шаблон и на всеки, който го
отвори от собствения си профил, ще му се попълват данните автоматично, ако

ги
е въвела предварително в настройките.
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4. Изпращане на еднотипен документ към множество
получатели
Инструментът за изпращане на писма в MS Word е изключително полезен,
особено когато трябва да изпратите един и същи документ (който обаче да
съдържа информация за получателя) към множество адресати. Тази функция
на програмата освен за бизнес кореспонденция, може да се използва за
изпращане на поздравителни картички, покани и т.н. Ако се заемем да
попълваме ръчно името, адреса, телефона или друга информация, то това ще
ни отнеме часове, а понякога и дни. С този инструмент можем да свършим
тази задача за няколко минути, стига да имаме таблица или предварително
изготвен списък с данните на получателите. Нека видим как:

За да използваме функцията Mail Merge отиваме в раздел Mailing > Select
Recipients. Ще ни се визуализират няколко начина за въвеждани на
информацията на получателите на нашето писмо.

Това е първият начин за въвеждане на данни, като това се случва изцяло в MS
Word. Тук не са ни нужни външни списъци или таблици.

Type a New List…
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Use an Existing List...
При този метод се използва съществуващ списък, най-често създаден в Excel.
Ако писмото е предназначено за бизнес кореспонденция, то повечето фирми
имат таблици с данните на своите клиенти, които могат да използват. Това е и
опцията,която препоръчваме да използвате!

Choose from Outlook Contacts...
Днес тази опция все по-рядко се използва. Тя ще ви бъде полезна, само ако
използвате Outlook за свой имейл и така да импортирате контактите си оттам.

За целите на нашия пример ще използваме втория метод, като предварително сме
си направили списък в Excel с получателите на писмото.
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Трябва да внимавате с обръщенията, тъй като в българския език, за разлика от
английския, те са малко по-специфични. Може да видите формулата, която сме
използвали, за да обвържем пола на човека със съответното обръщение. 

Също така подредбата на колоните не е нужно да бъде идентична с тази в

нашия
пример.
Отваряме отново Word, избираме Use an Existing List... и си намираме Excel
файла с информацията за нашите получатели. Натискаме OK и импортираме
данните.
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Можем да разгледаме имената в

Ако искаме да има обръщение към адресата, то изтриваме "Уважаеми......," и от
Insert Merge Field избираме "Обръщение" - не забравяйте да поставите
запетая 

След което трябва да посочим каква информация да се попълва на мястото на
полетата в текста. За целта маркитаме "Име на получателя", избираме Insert
Merge Field и избираме от списъка "Пълно_име". Правим същото по
аналогичен начин и за останалите полета. Попълваме ръчно информацията за
тези от тях, които няма да се променят, в зависимост от получателя.

Edit Recipient List.

след това!
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ВАЖНО! Преди да разпечатате писмата не забравяйте да махнете подчертаването
на полетата (Highlight Merge Fields)!

Разпечатването на писмата се случва чрез опцията Finish & Merge, като имате
няколко опции:

Тази функция на MS Word ще ви спести много време и усилия в ръчно въвеждане
на информация - използвайте я!

С Highlight Merge Fields автоматично ни се маркират полетата, които ще се
променят, а с Preview Results можем да видим как тези полета се заменят с
данните, които сме импортирали. Със стрелките можем да видим всички
писма, които сме генерирали.
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